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Micro Focus COBOL Server 2.2 Update 1
Release Notes

These release notes contain information that might not appear in the Help. Read them in their entirety
before you install the product.

Note: This document contains a number of links to external Web sites. Micro Focus cannot be
responsible for the contents of the Web site or for the contents of any site to which it might link. Web
sites by their nature can change very rapidly and although we try to keep our links up-to-date, we
cannot guarantee that they will always work as expected.

Micro Focus Heartbleed Update

The OpenSSL library used in this product has been updated to version 1.0.1g to fix the "Heartbleed"
vulnerability with TLS heartbeat requests.

COBOL Server Variants and Deploying Applications

Visual COBOL is available in different IDE variants, each one of which is targeted by one specific variant of
the development product:

• COBOL Server - the deployment environment for COBOL applications created with Visual COBOL for
Visual Studio 2010 or Visual COBOL for Eclipse

• COBOL Server 2012 - the deployment environment for COBOL applications created with Visual
COBOL for Visual Studio 2012

• COBOL Server 2013 - the deployment environment for COBOL applications created with Visual
COBOL for Visual Studio 2013

You can install and use all COBOL Server variants with the same license.

You can only deploy applications to the specific variant of COBOL Server that is targeted by the Visual
COBOL variant used to build the applications. For example, if you build your application using Visual
COBOL for Visual Studio 2012, you can only deploy the target files to COBOL Server 2012. The
application will not run in COBOL Server or COBOL Server 2013.

Note: Visual COBOL now includes support for creating Web service and Enterprise Java Bean
applications using the Interface Mapping Toolkit (IMTK) in conjunction with Enterprise Server. If you
are upgrading to this release from an earlier version of Visual COBOL, you may need to apply for a
new authorization code in order to access the functionality - please contact Micro Focus SupportLine
to receive an updated authorization code. Note that the Visual COBOL Personal Edition license does
not support the IMTK functionality.
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Installation

Installing on Windows

System Requirements for COBOL Server for Windows

Hardware Requirements
The disk space requirements are approximately:

Platform COBOL Server Sentinel RMS License Manager

x86 Windows platforms 190MB 35MB

x64 Windows platforms 290MB 35MB

Note: This includes the space needed to cache information locally so that you can modify the
installation without the original source media.

Operating Systems Supported
The following platforms are supported:

For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Note:

• COBOL Server 2012 and COBOL Server 2013 are not supported on versions of Windows earlier
than Windows 7.

• The Enterprise Server feature is not supported on Windows XP.

Software Requirements
Note: The setup file will check your machine for whether the prerequisite software is installed and will
install any missing prerequisites and the product components.

Before installing this product, you must have the following software installed on your computer:

• The Microsoft .NET Framework - the setup file installs Microsoft .NET Framework 4 with COBOL
Server, .NET Framework 4.5 with COBOL Server 2012, or .NET Framework 4.5.1 with COBOL Server
2013. You might need to install the following version of the .NET framework manually, if it is targeted by
your applications:

• Microsoft .NET Framework 2 - if your applications use the ILCLR(2) Compiler Directive or if they
target the .NET Framework versions 2, 3 or 3.5. You might need to download these installers
depending on the .NET Framework you are targeting.

To download the Microsoft .NET Framework 2 click here.

Microsoft .NET Framework 2 or later is also required for the Micro Focus License Manager if you
install this on a separate machine as a license server.

• Microsoft .NET Framework 4.5 might be required for COBOL applications created with Visual Studio
2012.

Installation | 5

http://supportline.microfocus.com/prodavail.aspx
http://www.microfocus.com/docs/links.asp?nx=FW20Redist


• Microsoft .NET Framework 4.5.1 might be required for COBOL applications created with Visual
Studio 2013.

Note:

• .NET Framework 3 is provided with Windows Vista and Windows Server 2008.
• .NET Framework 3.5 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.0 is provided with Windows 7 and Windows Server 2008 R2.
• .NET Framework 4.5 is provided with Windows 8 and Windows Server 2012.

• Microsoft's Web Platform Installer 2.0 if your application targets ASP.NET 4. This installs and sets up
ASP.NET. To download the installer click here.

• A Web browser is required for Enterprise Server Administration in COBOL Server.

To use your Web browser offline, you need the dial-up networking feature of Windows installed.
Otherwise you might have TCP/IP errors such as being unable find "localhost" or the numeric
equivalent (127.0.0.1).

• To use Enterprise Server Administration, scripting or JavaScript support must be enabled in your
browser. This is on by default in Internet Explorer in most Windows operating systems, apart from
Windows Server 2003. Also, active content must be allowed and not blocked. To enable both these in
Internet Explorer:

1. Click Tools > Internet Options.
2. On the Security tab, click Custom Level. In the Scripting section, under Active Scripting, click

Enable.
3. On the Advanced tab, scroll down the list to the Security section, and ensure the item Allow active

content to run in files on My Computer is checked.
• Enterprise Server Help requires the Java Runtime Environment on some Windows systems to enable

the Search facility to work.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements
To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file. The following information specifies the third-party software required for each feature.

• Application server support for JVM COBOL on page 6
• Consolidated Trace Facility on page 7
• Database Access on page 7
• XML Extensions

Application server support for JVM COBOL

Back to Top
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Restriction: This feature applies only when the Enterprise Server feature is enabled.

The following application servers are supported using the following JDKs:

Application Servers JDK version Containers support version

Tomcat 7.0.39 1.6 / 1.7 Servlets 2.5

JBoss 6.1 1.6 / 1.7 Servlets 2.5

WebLogic 12.1.1 1.6 / 1.7 Servlets 2.5

WebSphere 8.5 1.6 / 1.7 Servlets 2.5

You need Oracle's JDK. The earliest supported release of Oracle's JDK 1.6 is 1.6.027. You can download
Oracle's JDK from Oracle's Web site

Back to Top

Consolidated Trace Facility

• The Microsoft .NET Framework 2.0 or later is required for the CTF Viewer. It is available from the
Microsoft .NET downloads area.

Database Access

Back to Top

Before you can use COBOL Server to deploy SQL applications developed with OpenESQL, DB2 ECM, or
COBSQL, ensure any third-party software prerequisites are installed and the environment is set properly.
Refer to the your product help, Welcome > Product Information > Installing... > System
Requirements... > Additional Software Requirements > Database Access, for details.

XML Extensions

Back to Top

• XML Extensions has the same requirements as Visual COBOL. Both 32-bit and 64-bit versions are
available. See the XML Extensions for Visual COBOL, available from the Visual COBOL product
documentation section of the Micro Focus SupportLine Web site for more details.

• Additionally, XML Extensions may be used in conjunction with Terminal Server.

Installing COBOL Server for Windows

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Product Co-Existence
• Visual COBOL is available in different IDE variants, each one of which is targeted by one specific

variant of the development product:

• COBOL Server - the deployment environment for COBOL applications created with Visual COBOL
for Visual Studio 2010 or Visual COBOL for Eclipse

• COBOL Server 2012 - the deployment environment for COBOL applications created with Visual
COBOL for Visual Studio 2012
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• COBOL Server 2013 - the deployment environment for COBOL applications created with Visual
COBOL for Visual Studio 2013

• COBOL Server 2010, COBOL Server 2012 and COBOL Server 2013 cannot coexist on the same
machine.

Installation Restrictions and Requirements
Before starting the installation, you should consider the following:

• If you are installing this as an upgrade, make sure that none of the product files are in use when you
start the installation.

• You need to be logged in with a user-ID that has write access to the registry structure under
HKEY_LOCAL_MACHINE, HKEY_CLASSES_ROOT, and HKEY_CURRENT_USER so the installation
software can set the environment appropriately. You also need to be logged on with Administrator
privileges.

• Before installing this product, make sure that any existing Micro Focus Directory Server (MFDS) or
CCITCP2 Windows service (on Windows) or a process (on UNIX) from an existing product is stopped
and uninstalled. On Windows, do this as follows:

1. Stop the MFDS and CCITCP2, using either the Windows Service Management Console GUI
(services.msc) or from a command line prompt by typing:

net stop mf_ccitcp2

Only one instance of the MFDS or CCITCP2 service can run on a Windows machine.
2. Uninstall the MFDS or CCITCP2 service.

For MFDS, from a command line prompt enter: mfds -u

For CCITCP2: ccitcp2 -u

To run an earlier version of MFDS as a service after you have installed a later version:

1. Stop and uninstall the MFDS service, as described above.
2. Reinstall the earlier version, as follows:

a. Open a  COBOL Server command prompt.
b. Install the service. Enter the following command: mfds -i
c. Start the service. Enter the following command: net start mf_ccitcp2

Note: The two versions use different paths for environment and registry values, so the list of
configured enterprise servers might be different depending on which version has been started,
since, by default, different MFDS data repositories are used.

MFDS 5.1 and later are able to import or use Enterprise Server configuration data generated by earlier
versions of MFDS, but 5.0 or earlier versions of MFDS might not be able to read data generated by later
versions.

It is possible to run MFDS from a command prompt ("mfds") rather than as a service, but by default the
"mfcobol" port is used (86) and this can only be used by one process at a time

Installing as an Upgrade
This release will update an existing installation of COBOL Server 2.2.

Important:

• Before installing this release as an upgrade to an existing installation of the previous version 2.2 of
the product, you must uninstall any HotFixes of 2.2. This is to avoid some problems that might
result in files not being installed.

• Before installing this release as an upgrade, ensure you create a back-up of your Enterprise
Server configuration. To do this, on the Enterprise Server Administration home page, click Export
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and then select Export Enterprise Server configuration and Security Manager definitions.
This creates a backup folder in the c:\programdata\micro focus\Enterprise
Developer\MFDS. You can restore the Enterprise Server configuration after installing this release
- click Import on the Enterprise Server Administration home page.

Before installing, check Installation Restrictions and Requirements.

Installing
Note: See Installing as an Upgrade first for important information when upgrading an existing
installation of COBOL Server.

These are the steps to install this product:

1. Run the cs2010_221.exe file and follow the wizard instructions to install the prerequisite software and
the product.

Note: The respective installation files for COBOL Server 2012 and COBOL Server 2013 are
cs2012_release.exe and cs2013_release.exe.

Note:

• If you are installing onto a machine that has an existing Micro Focus product that uses an older
Sentinel RMS License Manager, you might be prompted to remove it and install the Micro Focus
License Administration. By doing this you maintain the existing Sentinel RMS license files while
adding the Micro Focus License Administration. If you are unsure about existing licenses on your
computer or removing the Sentinel RMS License Manager, consult your System Administrator. If
you want to proceed, remove Sentinel RMS License Manager by using Add or Remove
Programs (Windows XP) or Program and Features (Windows Vista or later), and rerun the
installation file.

• Trial licenses cannot be used with remote desktop services. If you want to use your product in this
way, please contact Micro Focus SupportLine to obtain a relevant license.

• We recommend that you install any updates for the .NET Framework that are available at the 
Microsoft Download site.

• If you install JDK you might be prompted to install the latest update. The latest update is not
required for use with COBOL Server but you can install it if you wish.

COBOL Server Installation Options
To install COBOL Server you run cs2010_221.exe which contains a number of product .msi files
(Windows Installer packages). When run, cs2010_221.exe performs some initial system checks then
sequentially installs the .msi files.

Note: This document only uses the filename of the executable for the product variant you have
installed - cs2010_release.exe. For COBOL Server 2012, the filename is
cs2012_release.exe, and for COBOL Server 2013 - the filename is cs2013_release.exe.

cs2010_221.exe can take a number of parameters, enabling you to specify a number of different types
of installation:

• Standard Installation

Format:
cs2010_221.exe

Summary:
Full installation including License Manager and COBOL Server. During installation you can specify
options including the location to which the components are installed.

• Non-interactive Installation

Format:
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cs2010_221.exe /passive

Summary:
Full installation, but the components are installed non-interactively using default options and
directories.

• Silent Installation

Format:
cs2010_221.exe /q

Summary:
Full installation, but the components are installed non-interactively with no user interface, using
default options and directories.

• Modified Silent Installation

Format:
cs2010_221.exe /q InstallFolder=d:\cobolrts

Summary:
Full installation, but the components are installed non-interactively with no user interface, and
COBOL Server is installed to d:\cobolrts.

To see what parameters you can use, execute the following from the command line:
cs2010_221.exe /?.

Note:

• Log files that are created during installation are saved in the folder specified by the TEMP
environment variable. To change the location or name of the files, use the /log parameter on your
setup command line and specify the path and file name, for example: filename /log d:\temp
\log.txt. This creates a log file, named log.txt, in the d:\temp directory.

After Installing
To open the help on versions of Windows 7 and earlier, select Start > All Programs > Micro Focus
COBOL Server > Documentation from the Windows Taskbar.

On Windows 8, right-click at the bottom of the Start screen, and click All apps to display all available links
for this product. In the COBOL Server section, click Documentation.

This starts the documentation for COBOL Server in the online Micro Focus Infocenter. From the left hand
pane, select Micro Focus Developer > Micro Focus COBOL Server.

Note: For applications created with earlier Micro Focus products or earlier versions of Visual COBOL,
note the following:

Database Access Managed applications using SQL(DBMAN=ODBC) that were compiled in
Visual COBOL 2.1 Update 1 must be recompiled in Visual COBOL 2.2
Update1.

Existing
Applications

Application executables that were compiled using earlier Micro Focus products
must be recompiled from the sources using Visual COBOL.

Repairing
If any product files, registry settings or shortcuts are accidentally removed at any point, you can perform a
repair on the installation to replace them.

To repair your installation on versions of Windows Vista or later:

1. From the Control Panel, click Uninstall a program under Programs.
2. Right-click your Micro Focus product and select Repair.

To repair your installation on older versions of Windows, such as Windows XP:
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1. Click Start Menu > Control Panel > Add/Remove Programs.
2. Click your Micro Focus product in the list of installed programs.
3. Click Click here for support information.
4. Click Repair.

Uninstalling
To uninstall the product, you cannot simply delete its files from your hard disk. To uninstall the product:

1. Log in with the same user-ID as you used when you installed the product.
2. Click Uninstall a program under Programs (or Add/Remove Programs on older versions of

Windows) in Control Panel.
3. On older versions of Windows such as Windows XP, ensure that Show Updates (at the top of the Add

or Remove Programs dialog) is checked, so that any hot fixes or WrapPacks are listed.
4. Select the product and click Remove or Uninstall as appropriate.

When you uninstall, the only files deleted are those that the installation software installed. If the product
directory has not been removed, delete any unwanted files and subdirectories within it using Windows
Explorer.

Important: The installer creates separate installations for Micro Focus COBOL Server and Micro
Focus License Administration. Uninstalling only COBOL Server does not automatically uninstall the
Micro Focus License Administration or any of the prerequisite software.

To completely remove the product you must uninstall the Micro Focus License Administration as well.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.

To silently uninstall the product, you need the setup file and you need to execute the following at the
command line:

start /wait install-file.exe /quiet /uninstall

Installing on UNIX

System Requirements for COBOL Server for UNIX

Hardware Requirements for COBOL Server
The disk space requirements are approximately:

Platform Setup

file size

(MB)

Disk space

required for

the installation

(GB)

Disk space

required for

running

the product

(MB)

Sentinel RMS

license server

(MB)

POWER running AIX 296 1.18 592 33

HP IA 619 2.48 1240 61

System Z running
Red Hat Linux

254 1.02 508 34

x86-64 running Red
Hat Linux

263 1.05 526 40
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Platform Setup

file size

(MB)

Disk space

required for

the installation

(GB)

Disk space

required for

running

the product

(MB)

Sentinel RMS

license server

(MB)

SPARC running
Solaris

308 1.23 616 38

x86-64 running
Solaris

284 1.14 568 30

System Z running
SuSE SLES

257 1.03 514 34

x86-64 running SuSE
SLES

266 1.06 532 40

Operating Systems Supported
For a list of the supported operating systems, check the Product Availability section on the Micro Focus
SupportLine Web site: http://supportline.microfocus.com/prodavail.aspx.

Software Requirements
Before installing this product, you must have the following software installed on your computer:

• The pax archiving utility is required by the setup file. Pax is distributed with most UNIX/Linux systems
but, if it is missing, you must install it separately. To verify pax is installed, run pax --help or pax --
version at the command line.

• On Red Hat 6.x, you must have the following operating system libraries installed:

glibc-*.x86_64
glibc-*.i686
libgcc-*.x86_64
libgcc-*.i686
libstdc++-*.x86_64
libstdc++-*.i686

In addition, on IBM System z (390), you must have the following operating system libraries installed:

glibc-*.s390
glibc-*.s390x
libgcc-*.s390
libgcc-*.s390x

Additional libraries for HCO for SQL Server Tools
glibc-devel-*.s390
glibc-devel-*.s390x

Visit the Red Hat Web site for more information.

• Oracle's Java Platform, Enterprise Edition (Java EE) 6 or Java 7 is required to execute COBOL JVM
code and for native COBOL and Java interoperability. The earliest supported release of Java 6 is 1.6
Update 27. You can download Oracle's Java EE from Oracle's Web site and install it anywhere on your
machine.

Note:
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• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK
1.6 is 1.6.0.13. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX JDL 1.6 is
Java 6.0.13. You can get the HP-UX Java JDK from HP's Web site.

Before you start the installation, you need to set the environment as follows:

• You need to set the LANG environment variable to pick up localized messages. The LANG settings are
English and Japanese only.

• The Java Development Kit (JDK) is required for compiling Java. The JDK is downloadable from 
www.oracle.com. After installing the JDK, you must put the tools.jar file for the JDK on your classpath,
using a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar

• JavaScript or scripting support must be enabled in your browser, so that Enterprise Server
Administration is usable. Also, active content must be allowed and not blocked.

Important: This release requires version 10000.2.990 or later of the Micro Focus licensing software.
For local servers, you do not need to install it separately, as the setup file installs a new Visual
COBOL client and a new licensing server on the same machine.

If you have a network server, you must update the license server before installing the product as the
client is not able to communicate with license servers of versions older than 10000.2.660. On
Windows, you can check the version of your license server by clicking Help > About in the Micro
Focus Licensing System Administration tool. To check the version of the license server on UNIX,
run /var/microfocuslicensing/bin/mfcesver or /var/microfocuslicensing/bin/
cesadmintool.sh.

You can download the new version of the license server software from the Micro Focus SupportLine
Web site: http://supportline.microfocus.com.

Additional Software Requirements on Linux and UNIX
To ensure full functionality for some COBOL Server features, you might be required to obtain and install
additional third-party software in addition to the prerequisite software installed automatically by the COBOL
Server setup file. The following information specifies the third-party software required for each feature.

• Application server support for JVM COBOL on page 13
• Database Access on page 14
• Java Development Kit (JDK) on page 14
• XML Extensions on page 14

Application server support for JVM COBOL

Back to Top

Restriction: This topic applies only when the Enterprise Server feature is enabled.

The following application servers are supported using the following JDKs:

Application Servers JDK version Containers support version

Tomcat 7.0.39 1.6 / 1.7 Servlets 2.5

JBoss 6.1 1.6 / 1.7 Servlets 2.5

WebLogic 12.1.1 1.6 / 1.7 Servlets 2.5

WebLogic 12.1.1 on AIX 6.1 1.6.0 SR10 FP1 / 1.7 Release 1 Servlets 2.5

WebSphere 8.5 1.6 / 1.7 Servlets 2.5
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Application Servers JDK version Containers support version

WebSphere 8.5 on AIX 6.1 1.6.0 SR10 FP1 / 1.7 Release 1 Servlets 2.5

Note:

• On AIX and zLinux, you need to have IBM's JDK. The earliest supported release of IBM's JDK 1.6
is 1.6.0.13. You can get IBM's AIX JDK from IBM's Web site.

• On HP-UX, you need to have HP-UX JDK. The earliest supported release of HP-UX JDL 1.6 is
Java 6.0.13. You can get the HP-UX Java JDK from HP's Web site.

• On all other platforms, you need Oracle's JDK. The earliest supported release of Oracle's JDK 1.6
is 1.6.027. You can download Oracle's JDK from Oracle's Web site.

Database Access

Back to Top

Before you can use COBOL Server to deploy SQL applications developed with OpenESQL, DB2 ECM, or
COBSQL, ensure any third-party software prerequisites are installed and the environment is set properly.
Refer to the your product help, Welcome > Product Information > Installing... > System
Requirements... > Additional Software Requirements > Database Access, for details.

Java Development Kit (JDK)

Back to Top

Compiling
Java

Either the IBM or the Oracle Java Development Kit (JDK), version 1.5 or later, is required
for compiling Java. The JDK is downloadable from the Oracle and IBM Web sites. After
installing the JDK, you must put the tools.jar file for the JDK on your classpath, using
a command similar to:

 set classpath=jdk-install-directory\lib\tools.jar

IMTK The JDK is required for generating Java interfaces using the Deploy tool in the Interface
Mapping Toolkit or the imtkmake command.

After installing the JDK, you need to set up your Java environment.

XML Extensions

Back to Top

• XML Extensions has the same requirements as Visual COBOL. Both 32-bit and 64-bit versions are
available. See the XML Extensions for Visual COBOL, available from the Visual COBOL product
documentation section of the Micro Focus SupportLine Web site for more details.

• Additionally, XML Extensions may be used in conjunction with Terminal Server.

Installing COBOL Server for UNIX

Downloading the Product
1. Use the download links in your Electronic Product Delivery email.

For more information follow the links for the installation instructions and the End User License
Agreement.

Installing
These are the steps to install this product:
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1. Give execute permissions to the setup file:

chmod +x setup_cobol_server_2.2_update1_platform

2. Run the installer with superuser permissions:

./setup_cobol_server_2.2_update1_platform

If you don't run this as superuser, you are prompted to enter the superuser password during the install.

If you set COBDIR to an already installed product, the installer will back up the existing installation and
will install this release in the location COBDIR points to. If COBDIR is not set, the installer does a fresh
install.

The COBOL run-time is installed by default into /opt/microfocus/VisualCOBOL, (COBDIR).

To install in a different location use the -installlocation="Location" parameter to specify an
alternative directory location. For example:

./setup_cobol_server_2.2_update1_platform -installlocation="full path of 
new location"

Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

You can see details about which additional parameters can be passed to the install script if you enter
the -help option.

You can use the following options to configure the Enterprise Server installation: [ -
ESsysLog="location" ] [ -ESadminID="User ID" ] [ -CASrtDir="location" ],
where:

-ESsysLog Specifies a location in which the build will create the Enterprise Server System log file -
for example, -ESsysLog="/home/esuser/logs". The default location is /var/
mfcobol/logs.

-ESadminID Sets the Enterprise Server System Administrator Process User ID from the command
line - for example, -EDadminID="esadm". The default user ID is the one that runs the
installer.

-CASrtDir Specifies the location were the Enterprise Server run-time system files are placed - for
example, -CASrtDir="/home/esuser/casrt/es". The default location is /var/
mfcobol/es.

Note:

• The installation of this product could affect the SafeNet Sentinel licensed components running on
your machine. During installation licensing is shutdown to allow files to be updated. To ensure the
processes running on your machine are not affected, you need to use the -skipsafenet option,
which skips the installation of SafeNet:

./setup_cobol_server_2.2_update1_platform -skipsafenet

• To protect the SafeNet Sentinel installation from accidental updating you can create an empty file
named SKIP_SAFENET_INSTALL in /var/microfocuslicensing/ as follows:

touch /var/microfocuslicensing/SKIP_SAFENET_INSTALL

While the file is present, the SafeNet installer does not make changes to the installation or
shutdown the running license daemons. If licensing needs to be updated later, remove the file and
install Sentinel RMS server manually.
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After Installing
When you have installed the product, you need to set the environment as described below.

1. To set up your product, execute:

. /opt/microfocus/VisualCOBOL/bin/cobsetenv

2. To verify that your product is installed, execute:

cob -V

Important: These commands set the environment only for the current shell. You need to execute
them for each new shell that you start.

To avoid having to run cobsetenv for every shell, add these commands to the shell initialization files
(such as etc/profile, etc/bashrc).

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installing as an Upgrade
This release works concurrently with the previous version of COBOL Server, so you do not need to
uninstall it. There are two options for installing the latest version in this case:

• Move the existing installation to a different location and install the latest version to the default install
location specified by the COBDIR environment variable ( /opt/microfocus/VisualCOBOL, by
default).

This ensures you do not need to change your environment. To move the existing older installation to a
different location:

1. Execute the following command as root:

mv /opt/microfocus/VisualCOBOL /opt/microfocus/VisualCOBOLversion

2. Install the latest version as described in the section Installing.
• Install the latest version in a different location and set the environment to point to it. To do this, run the

COBOL Server installer with the –installlocation option:

1. Execute the following command:

. /InstallFile -installlocation="/opt/microfocus/VisualCOBOL"

Note: You can use variables or the tilde syntax for the path for –installlocation. For
example, the following examples are equivalent:

-installlocation="/home/myid/installdir"

-installlocation="~myid/installdir"

-installlocation="~/installdir"

-installlocation="$HOME/installdir"

2. Execute cobsetenv to set the environment and point to the new install location:

. /opt/microfocus/VisualCOBOL/cobsetenv

Note that cobsetenv is only compatible with POSIX-like shells, such as bash, ksh, or XPG4 sh. It is
not compatible with C-shell or pre-XPG4 Bourne shell.

Installing silently
You can install Micro Focus products silently by using command line parameters to specify the installation
directory, user information, and which features to install. You must execute the command with superuser
permissions.
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You can use the following command line arguments to install silently on UNIX/Linux:

–silent -IacceptEULA

For example, execute:

[as root] setup_filename –silent -IacceptEULA

After the application installation is complete you can install the license silently by executing the following
commands:

If you have access to the Internet
and an authorization code

Run the following as root:

cd /var/microfocuslicensing/bin
./cesadmintool.sh -authorize AuthorizationCode

If you don't have access to the
Internet but have a file from Micro
Focus that contains the license
string

Run the following as root:

cd /var/microfocuslicensing/bin
./cesadmintool.sh -install FileName

where FileName is the name of the text file that contains all the
license strings to be used.

UNIX and Linux Installer Issues

Installing on
Linux

On Linux, the 32-bit version of Java is required to install and use Visual COBOL for
Eclipse. When you start the installation, if the 64-bit version of Java is already installed
on your Linux machine, you might not be able to install Visual COBOL. This is a known
issue with the Oracle Java installers for Linux which prevent you from installing both the
32-bit and the 64-bit versions of Java on the same machine. To work around this
problem:

• Download the 32-bit Java distribution in a compressed .tar format from the Oracle
Web site.

• Untar the distribution into a location different from the one used for the 64-bit Java
version. For example, untar in /usr/local/java32 and not in /usr/local/
java.

• Set JAVA_HOME and LD_LIBRARY_PATH to the 32-bit version of Java so that it is
used to install and run Visual COBOL.

License
Infrastructure
Installer

• On some Solaris platforms, you can receive the following error message when
SafeNet license server needs to be installed or upgraded on your machine:

tar: /safenet.tar: No such file or directory

To resolve this issue, wait for the installation to complete and then perform the
following:

1. Navigate to the safenet directory in the COBDIR location.
2. With superuser permissions execute: ./MFLicenseServerInstall.sh

• Note: The following information applies when you are installing on Red Hat
Enterprise Linux (RHEL) 7. (RHEL 7 is a beta version and support for it is a
technical preview only).

Certain configuration changes in RHEL 7 (such as the /etc/inittab file no longer
available) required a change in the MF SafeNet license installer for this platform and
the way you can manually manage the licensing service.

By default, the MF SafeNet licensing service is still configured so that it starts
automatically when starting your machine. Only on RHEL 7, you must use the
systemctl command available with the OS if you need to override the default
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behaviour – for example, if you do not want run the MF SafeNet licensing service at
start-up or if you do not want the service to automatically start when you are
configuring trace levels.

1. Create a file, MFSafeNet.service, in /usr/lib/systemd/system/ with the
following contents:

----------- start of /usr/lib/systemd/system/
MFSafeNet.service -----------
    [Unit]
    Description=Micro Focus SafeNet licensing daemons. 
    Documentation=http://supportline.microfocus.com

    [Service]
    Type=forking
    ExecStart=/var/microfocuslicensing/bin/startboth.sh
    ExecStop=/var/microfocuslicensing/bin/stopboth.sh
    Restart=no

    [Install]
    WantedBy=multi-user.target
-----------  end of /usr/lib/systemd/system/
MFSafeNet.service  -----------

2. Use the systemctl command to manage the SafeNet service:

[ asroot ] systemctl option MFSafeNet

Where some of the values that option can take are:

reenable Installs the SafeNet service.

is-enabled Checks the status of the SafeNet service. Does not require root
privileges.

start Starts the SafeNet service.

stop Stops the SafeNet service.

restart Restarts the SafeNet service.

disable Disables the SafeNet service so it does not start when the
machine is booted.

enable Enables the SafeNet Service so it starts when the machine is
booted.

For more information about systemctl, refer to the help available with the RHEL
OS.

License Server You need to configure the computer hostname to ensure the license server will start
properly.

To avoid performance issues, "localhost" and the computer hostname must not both be
mapped to IP address 127.0.0.1. You should only map "localhost" to IP address
127.0.0.1.

The following is an example of how to specify these entries correctly in the etc/hosts
file:

127.0.0.1 localhost.localdomain localhost
IP machinelonghostname machineshorthostname

where IP is the unique IP address of the computer in xx.xx.xx.xx format.
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Repairing
If a file in the installation of the product becomes corrupt, or is missing, we recommend that you reinstall
the product.

Uninstalling
Note: Before you uninstall the product, ensure that the Enterprise Server instances and the Micro
Focus Directory Service (MFDS) are stopped.

To uninstall this product:

1. Execute as root the Uninstall_COBOLServer2.2.sh script in the $COBDIR/bin directory.

Note: The installer creates separate installations for the product and for Micro Focus License
Administration. Uninstalling the product does not automatically uninstall the Micro Focus License
Administration or the prerequisite software. To completely remove the product you must uninstall the
Micro Focus License Administration as well.

To uninstall Micro Focus License Administration:

1. Execute as root the UnInstallMFLicenseServer.sh script in the /var/
microfocuslicensing/bin directory.

The script does not remove some of the files as they contain certain system settings or licenses.

You can optionally remove the prerequisite software. For instructions, check the documentation of the
respective software vendor.
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Licensing Information
Note:

• If you have purchased licenses for a previous release of this product, those licenses will also
enable you to use this release.

• The latest version of the SafeNet licensing software is required. See the Software Requirements
section in this document for more details.

• Your entitlement for using this product is governed by the Micro Focus End User License
Agreement and by your product order. If you are unsure of what your license entitlement is or if
you wish to purchase additional licenses, contact your sales representative or Micro Focus
SupportLine.

To buy and activate a full unlimited license
To buy a license for Visual COBOL, contact your sales representative or Micro Focus SupportLine.

For instructions on using the Micro Focus Licensing Administration Tool, see Licensing in the Visual
COBOL help.

To start Micro Focus License Administration

From the Windows Taskbar click Start > All Programs >Micro Focus License Manager > License
Administration.

Note: On Windows 8 and Windows Server 2012, you use the Start screen to invoke programs.

Log on as root, and from a command prompt type:

/var/microfocuslicensing/bin/cesadmintool.sh

Installing licenses

If you have a license file

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Do one of the following:

• Click Browse next to the License file field and select the license file (which has an extension
of .mflic).

• Drag and drop the license file from Windows Explorer to the License file field.
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• Open the license file in a text editor, such as Notepad, then copy and paste the contents of the file
into the box below the License file field.

4. Click Install Licenses.

1. Start the Micro Focus License Administration tool and select the Manual License Installation option by
entering 4.

2. Enter the name and location of the license file.

If you have an authorization code

Authorizing your product when you have an Internet connection
Note: This topic only applies if you have an authorization code.

The following procedure describes how to authorize your product using a local or network license server.
The license server is set up automatically when you first install the product.

1. Start Micro Focus License Administration.
2. Click the Install tab.
3. Type the authorization code in the Enter authorization code field.
4. Click Authorize.

If you change the name of the machine running your license server after it has granted licenses, the
licenses stop working.

1. Start Micro Focus License Administration.
2. Select the Online Authorization option by entering 1 and pressing Enter.
3. Enter your authorization code at the Authorization Code prompt and then press Enter

Authorizing your product when you don't have an Internet connection
Note: This topic only applies if you have an authorization code.

This method of authorization is required if your machine does not have an Internet connection or if normal
(automatic) authorization fails.

1. Start Micro Focus License Administration.
2. Click Manual Authorization on the Install page.
3. Make a note of the contents of the Machine ID field. You will need this later.
4. Do one of the following:

• If your machine has an Internet connection, click the SupportLine Web link in the Manual
Authorization Information window.

• If your machine does not have an Internet connection, make a note of the Web address and type it
into a Web browser on a machine that has an Internet connection.

The Micro Focus SupportLine Manual product authorization Web page is displayed.
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5. Type the authorization code in the Authorization Code field. The authorization code is a 16-character
alphanumeric string supplied when you purchased your product.

6. Type the Machine ID in the Machine ID field.
7. Type your email address in the Email Address field.
8. Click Generate.
9. Copy the generated license string (or copy it from the email) and paste it into the box under the License

file field on the Install page.
10.Click Install Licenses.

In order to authorize your product you must have the following:

• Your authorization code (a 16-character alphanumeric string).
• The machine ID. To get this, start the Micro Focus License Administration tool and select the Get

Machine Id option by inputting 6. Make a note of the "Old machine ID".

If you have previously received the licenses and put them in a text file, skip to step 6.

1. Open the Micro Focus license activation web page http://supportline.microfocus.com/activation in a
browser.

2. Enter your authorization code and old machine ID and, optionally, your email address in the Email
Address field.

3. Click Generate.
4. Copy the licenses strings from the web page or the email you receive into a file.
5. Put the license file onto your target machine.
6. Start the Micro Focus License Administration tool and select the Manual License Installation option by

inputting 4.
7. Enter the name and location of the license file.

To obtain more licenses
If you are unsure of what your license entitlement is or if you wish to purchase additional licenses for Visual
COBOL, contact your sales representative or Micro Focus SupportLine.
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New Features in COBOL Server 2.2 Update
1

ACUCOBOL-GT Compatibility
The following ACUCOBOL-GT support has been added in this release:

-Di compiler option The -Di compiler option, which initializes Working-Storage data items based in their
type, is now supported.

Compiler Directives
The following compiler directives have been added in this release:

ILPARAMS Determines the way in which you call a method that contains an array as its last receiving
parameter.

INIT-BY-
TYPE

Initializes Working-Storage Section data items to a default value, according to their type.

• Alphabetic, alphanumeric, alphanumeric edited, and numeric edited items are initialized
to spaces.

• Numeric items are initialized to zero.
• Pointer items are initialized to null.
• Index items are initialized to the value 1.

Fileshare Recovery
Recovery of Fileshare data files has been enhanced.

Rollback recovery is a faster process that aims to fix the files from their failed state.

This process cannot be used in all scenarios, but a new user exit has also been introduced that allows you
to programmatically control which files you wish to recover with this process.

Hot backups are also a new introduction, which allow you to perform a backup without having to shut down
Fileshare.

Micro Focus Heartbleed Update
The OpenSSL library used in this product has been updated to version 1.0.1g to fix the "Heartbleed"
vulnerability with TLS heartbeat requests.

Run-time Support
The following new features have been added as part of the run-time support
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Run-time Launch Configuration Files

Note: This feature is only supported in a Windows environment.

Use a run-time launch configuration file to ensure an application can be launched when it is deployed in a
separate location to the run-time system (in the case of dynamically bound applications), or when the
licensing daemon is not already running.

Environment Variables

The following environment variable has been added in this release:

strictvsam strictvsam enables strict mainframe emulation when processing VSAM files.

When set to ON and running under mainframe emulation, file status 37 is returned for an
existing VSAM file when opened for OUTPUT if the file has data or previously had data
written to it, or if the file is of a different format to the file on disk. When set to OFF, file status
0 is returned and a new file is created when an existing VSAM file is opened for OUTPUT.
This variable is set to OFF by default.

New Terminfo files
The following terminfo files have been added for this release:

• ansi80x25 - this is based on the old ansi file. A newer version of ansi exists in this release that has no
function key support, which is consistent with ansi terminfo files on various other UNIX platforms. If you
currently use ansi and require function key support, you should instead set the TERM environment
variable to ansi80x25 to continue previous behavior.

• xterm-color and kterm-color - these are now available on all UNIX platforms - previously, they were only
available on Linux.

• aixterm-old (AIX systems only) - this has similar capabilities to the AIX OS terminfo file of the same
name. It differs from the existing aixterm file, because it has no line drawing capability. Line drawing is
only possible with aixterm if it is displayed on an appropriate display (X server).

• vt220-w - this is the wide (132-column) version of the vt220 file, and is based on the vt100-w file. For
more information, see Wide Terminal Mode in the documentation referenced at the bottom of this
section.

There have been a number of additions and fixes to existing terminfo files; refer to the Terminfo Database
and Terminal Devices section of the documentation for full details.

There have also been a number of terminfo files that have been removed; refer to the Backward
Compatibility section for a complete list.
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Known Issues
Refer to the Known Errors and Restrictions topic in the Product Information section of your product Help.

In addition, note the following:

Enterprise
Server

• The Historical Statistics Facility may generate incorrect records for SSTM-enabled
enterprise servers.

ICETOOL
Emulation

ICETOOL emulation for managed code is not available in this release.

Installation • Before installing this release as an upgrade to an existing installation of the previous
version 2.2 of the product, you must uninstall any HotFixes of 2.2. This is to avoid
some problems that might result in files not being installed. This is required only on
Windows.

• Before installing this release as an upgrade, ensure you create a back-up of your
Enterprise Server configuration. To do this, on the Enterprise Server Administration
home page, click Export and then select Export Enterprise Server configuration
and Security Manager definitions. This creates a backup folder in the c:
\programdata\micro focus\Enterprise Developer\MFDS. You can restore
the Enterprise Server configuration after installing this release - click Import on the
Enterprise Server Administration home page.

• On UNIX, check UNIX Installer Issues before you start the installation.

Resource
Adapters

Trying to deploy the local resource adaptor mfcobol-localtx.rar to WebLogic may
fail with a ClassCastException. To work around this issue, you need to deploy mfcobol-
xa.rar first, then need to undeploy this file and deploy the local one, mfcobol-
localtx.rar. If there are issues deploying using the WebLogic GUI, you can use the
command line. If there are issues with this as well, try reducing the length of the
command (for example, by moving the file to a location with a shorter path).
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Significant Changes in Behavior or Usage
This section describes significant changes in behavior or usage. These changes could potentially affect the
behavior of existing applications or impact the way the tools are used.

The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• .NET Compiler
• SQL: COBSQL

.NET Compiler

Back to the list

• In member reference in managed COBOL syntax, you may now only use parentheses when referencing
methods. You can no longer specify parentheses when referencing fields or properties, as this will
produce a syntax error. For example:

set intLength to testString::Length()

must change to:

set intLength to testString::Length

SQL: COBSQL

Back to the list

• COBSQL now displays appropriate COBOL syntax errors after encountering EXEC SQL statement
errors.

2673619 (1093197)
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Resolved Issues
The numbers that follow each issue are the Support Incident Numbers followed by the Reported Problem
Incident (RPI) number (in parentheses).

• .NET Compiler
• .NET ESQL Support
• .NET RTS
• Adis
• CAS (COBOL App Server) General
• CAS Admin Console
• CAS Resource Manager Interface
• CAS Security
• CAS XA Switch modules
• CASRDO
• Compiler
• Compiler ECM Support
• Cobdebug
• Documentation
• ES Monitor/Control (ESMAC)
• File Handling - External File Handler
• File Handling - Fileshare
• Interface Mapping Toolkit General
• JVM - Compiler
• JVM - RTS
• LE370 Support
• MDSA API for CAS
• MF Communications Server
• MF Directory Server
• MF Server Administrator (GUI)
• MFIO
• Micro Focus Heartbleed Update
• NCG
• Run-Time System
• Setup Issues (UNIX)
• SQL: COBSQL
• SQL: DB2 ECM
• SQL: HCO for SQL Server
• SQL: OpenESQL
• UNIX Cob
• Web Service Client
• XDB Server
• XDB: Problems not classed above
• XML Syntax Support Preprocessor
• XML Syntax Support Runtime

.NET Compiler

Back to the list
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• When compiling for managed code with the RM(ANSI) directive, the EXIT PROGRAM statement now
works as expected. Previously, it was causing all files open in the program to be closed, which should
only occur if the RM directive (without the ANSI parameter) is specified.

2690872 (1093437)
• (As 1091900) Previously, when the NOBOUND directive was set, generation of a level 88 condition

name on a subscripted item could result in a system error.

2685375 (1093076)
• An INITIALIZE statement without the REPLACING phrase now initializes PIC N data items to DBCS

spaces (x"8140"). In a previous version, this was incorrectly initializing to ASCII spaces (x"20").

2682846 (1092779)
• An INITIALIZE statement applied to a particular element of a subscripted group, where a space fill

should precede a sub-occurs item, now applies the space filling to the correct element of the
subscripted group.

2682845 (1092778)
• A problem has been fixed where an INITIALIZE statement referencing a group that redefines something

did not function correctly if the group itself was not otherwise referenced.

2681790 (1092700)
• Arithmetic statements involving subscripted operands no longer cause bad code generation. Previously,

this was likely to happen when the subscripted data item was declared at 01 level, or was declared
within a group, which itself was never referenced.

2677890 (1092368)
• In previous product versions, the event which was the target of an attach or detach statement could not

be specified as the end of a member reference chain. This meant that it was not possible to have
statements like:

attach method self::MyMethod to self::TextBox::TextChanged

This is now fixed.

2676123 (1092130)
• Property initializers as part of the 'new' (constructor) expression are now functioning correctly.

2674668 (1091974)
• Previously, when the NOBOUND directive was set, generation of a level 88 condition name on a

subscripted item could result in a system error.

2673571 (1091900)
• Previously, a mixture of static and instance files within a class could result in bad code generation. This

has now been resolved.

2672322 (1091732)
• Previously, in situations where a reference-modified move from a pic x to a pic n field has the same

length expression on each side, compiling produced incorrect code which resulted in the target being
truncated.

2670726 (1091595)
• Type inference for generic methods is now working as expected. Previously, in certain cases, it was

causing 'COBCH0829 Could not find method...' errors.

2670658 (1091643)
• Programs compiled to managed code, and which use the SSRANGE directive, no longer produce

system errors at compile time.

2668437 (1091389)
• After stepping into an INVOKE or a PERFORM statement, the call stack will now point to the INVOKE

or PERFORM itself, and not to the statement following it.
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(583690)
• When compiling for .NET, XML comments that are attached to types and members (for example,

methods and fields) now generate warnings if the XML text is not correctly formatted.

(595368)
• Previous versions of the product allowed the caller of a method, in which the last parameter was an

array, to specify a list of zero or more arguments of the array element type, in place of a single array
argument. By default, this behavior is now only supported when the array parameter in the target
method has the PARAMS attribute. To restore the old behavior, the new ILPARAMS directive has been
introduced.

(599666)
• Previously, the resolution of shortened type names (those without explicit namespace) could fail when

different programs had different ILUSING lists. This could occur when there were multiple programs in a
project and one or more of them had $set statements with the ILUSING directive.

(599903)
• A problem where generic classes would wrongly appear to have errors on background parse has been

resolved.

(601182)

.NET ESQL Support

Back to the list

• OpenESQL did not correctly handle EXEC ADO BIND CONNECTION statements that passed the
connection name in a host variable.

2681358 (1092636)
• Previously, the OpenESQL precompiler split DBCS SQL statements which resulted in receiving a

managed OpenESQL run-time error when processing the statements.

2672260 (1091722)
• The LIKE operator was not invoked properly for .NET DATAROWS cursor search conditions.

2671820 (1091683)
• Some consistency issues with sensitive cursors have been resolved in the ODBC, JDBC and ADO run-

time systems for OpenESQL.

2667592 (1091300)

.NET RTS

Back to the list

• An error when converting values from type decimal to other COBOL data types has been fixed.

2695116 (1093886)

Adis

Back to the list

• REVERSE-VIDEO now works as expected when using the X"AF" function.

2683509 (1092851)
• MS ACCEPT statements now sound a beep when invalid characters are entered into integer or decimal

fields. Integer fields no longer accept invalid characters and normalise.

2680081 (1092542)
• MS ACCEPT statements now display numerics with space fill and sign leading so that integers and

decimals are appropriately aligned.
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2680081 (1092543)
• The attributes specified in the screen section are now displayed correctly after a call to the X"AF"

function 81 has been made.

2650012 (1089634)

CAS (COBOL App Server) General

Back to the list

• Multiple casout calls (using the -r option) in a single process now work correctly.

2694290 (1093800)
• When accessing TS/TD on error, the file status is now displayed correctly.

2684719 (1093023)
• HSF records no longer contain incorrect dates when a task runs past midnight at the end of a month.

2644616 (1089363)
• Messages issued from casstop are now sent to stdout.

2643162 (1089019)
• All system abend messages are now reported to the console.

(602933)

CAS Admin Console

Back to the list

• The JES Program Path and CICS Transaction Path now accept paths of up to 4096 characters.

2665324 (1091104)

CAS Resource Manager Interface

Back to the list

• A thread synchronisation issue was causing responses to be lost intermittently. For stateful requests,
this could result in lost SEPs (whereby a SEP would appear as busy even though it was not processing
any work).

2686429 (1093442)

CAS Security

Back to the list

• A new user objectclass instance added to an LDAP-based external security manager now has its initial
login attempts count value set correctly.

2637659 (1088656)

CAS XA Switch modules

Back to the list

• A new SQL Server XA switch module provides support for xa_recover and also handles implicit rollback
by SQL Server more cleanly than previous switch modules.

2679162 (1092481)

CASRDO

Back to the list
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• Clicking Resources > JES > Catalog in ESMAC now opens the initial screen without showing the
results of any previous searches.

2656391 (1090454)

Compiler

Back to the list

• LOCAL-STORAGE data in nested programs now behaves as expected and as it does on the
mainframe - as LOCAL-STORAGE of the main program.

2693843 (1093746)
• A MOVE from a group item to a DBCS target that requires padding now behaves as expected.

2692634 (1093553)
• DELETE statements that contain the END-DELETE scope terminator now compile as expected.

2690465 (1093235)
• UNSTRING on LINKAGE SECTION data items with reference modification could sometimes give the

wrong result.

2684812 (1092998)
• Using large EXEC SQL statements no longer causes the Compiler to hang.

2684713 (1092993)
• The ? NUMERO SIGN (U+2116) Shift-Jis FA59/8782 is now converted correctly to EBCDIC value 446e

under CHARSET(EBCDIC).

2683297 (1092823)
• MOVE figurative constant to PIC G item under CHARSET(EBCDIC) now returns the expected results.

2683091 (1092801)
• A MOVE CORRESPONDING statement with a GLOBAL subscripted target now compiles as expected.

2682557 (1092981)
• A program compiled with the FDCLEAR Compiler directive and containing a numeric file record now

compiles as expected.

2678050 (1092326)
• The asterisk character is now treated correctly in COPY REPLACING text under mainframe emulation.

2676006 (1092571)
• A literal greater than 80 bytes but less than 160 bytes in length and containing non-ASCII characters

will now compile as expected with a mainframe dialect.

2670083 (1091560)
• Programs that contain EXEC INCLUDE statements inserted by a preprocessor now debug as expected.

2661838 (1091416)
• ISO2002 and SNI table VALUE syntax is now working as expected for multi-dimensional tables that are

not directly nested within each other.

2651916 (1089808)
• The Compiler error message 62 (COBCH0062) has been clarified by changing "Nested COPY

replacement not supported" to "Nested COPY replacement causes termination of parent COPY
replacement".

(599823)
• The SQL TYPE DBCLOB(n) now creates the correct COBOL record structure.

(599679)
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Compiler ECM Support

Back to the list

• The SQL(CHECK) option no longer incorrectly affects the setting of the unrelated NCG option 'CHECK'.

2685791 (1093351)

Cobdebug

Back to the list

• When stepping through a program that has a watchpoint set in it, all statements are now being stepped
correctly.

2664045 (1091500)

Documentation

Back to the list

• You may now specify an SSL-enabled listener when submitting jobs via CASSUB. You achieve this by
using the tcpssl protocol on the /s or -s switch.

2671020 (1091619)
• A compiler directive INIT-BY-TYPE has been provided to allow initialization of each data type to a

sensible value for that type.

2650462 (1091658)
• The INITIALIZE verb now supports multiple categories in a single REPLACING clause.
• Variable length record files that are 4 bytes or smaller are padded to 8 bytes.

2537147 (1081777)

ES Monitor/Control (ESMAC)

Back to the list

• In the ESMAC (casrdo45) page, there is now provision to filter and list the members of a particular PDS.
The filter text is PDSNAME(*). The PDSNAME should be the complete name of the PDS, and cannot
contain any wildcards.

2500753 (1078391)

File Handling - External File Handler

Back to the list

• When using the RMFM File Handler, a file status '05' is returned when executing a DELETE FILE
statement, if appropriate. This emulates the behavior of the RM/COBOL run-time.

2685220 (1093089)
• A rollback recovery of a REWRITE where the record size was being reduced was producing incorrect

results.

2685069 (1093085)
• When a DD name is associated with several concatenated data sets of different charsets, the returned

data has the charset encoding of the first data set. However, if the first data set is LSEQ, the returned
data has the charset encoding of the application program.

2677941 (1092434)
• cobfhrepro2 now produces the correct output for FCD2.

2664465 (1090972)
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• A new environment variable, STRICTVSAM, has been introduced. When it is set to ON and under a
mainframe emulation, a file status of 37 is returned when you open an existing VSAM file for OUTPUT
and the file has or previously had some data written to it, or if the file format is different from the file on
disk. The default for this variable is OFF.

2660766 (1090639)
• When reading concatenated datasets, each dataset in concatenation must use the same RECFM,

either all FB or all VB.

2654517 (1091793)
• The FOLDER section in a file handler configuration file now supports relative paths.

2653787 (1090290)
• Btrieve files are now supported, using the xfh2btr call conversion module, for native COBOL, running in

a Windows environment.

2598434 (1086466)
• 64-bit fileshare clients would fail to connect if any cci configurations settings were used.

File Handling - Fileshare

Back to the list

• The Escape character was not being honoured for filenames passed to FSVIEW which caused
filenames containing $ to be interpreted as environment variables.

2660207 (1093021)
• MFJSORT now correctly displays the file status of a queried VSAM file, rather than a generic error

message, when the file being queried returns a non-zero file status.

2589273 (1092107)

Interface Mapping Toolkit General

Back to the list

• RESP condition code information is now available to COMMAREA Web Service clients when EXEC
CICS LINK errors occur.

2671956 (1093056)
• The Driver Program name of a COMMAREA Service Interface cannot be the same as an operation's

program name. Service Interface Validation now performs a check for this.

2669112 (1091799)

JVM - Compiler

Back to the list

• The statement ACCEPT operand FROM DATE-ISO4 now works correctly in .NET and JVM COBOL.

2681556 (1092861)
• When compiling for JVM COBOL, COMPUTE statements within a large perform range, where the

arithmetic expression involves division by a power of 10 now produces the expected results.

2680641 (1092792)
• A new Compiler directive has been introduced to control how a method that has an array as its last

parameter can be called. When ILPARAMS is set (which is the default), you can call the method using a
list of items of the same array element type, instead of specifying a single array. When ILPARAMS is
not set, you can only specify a list of items if the target method has the PARAMS attribute. Previous
compiler versions allowed the use of a list even when the method did not have the PARAMS attribute,
which is equivalent to the current default behavior.
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JVM - RTS

Back to the list

• Fixed an error in arithmetic statements in JVM COBOL where the target is a comp-2 item.

2691797 (1093424)

LE370 Support

Back to the list

• LE370 parameters that continue on the next line are no longer flagged.

2681691 (1092669)
• TSO ALLOCATE command emulation now supports the use of "F B".

2668742 (1091453)
• An unsupported LE option in the code no longer invalidates the options that follow.

2668740 (1091425)
• A fault that caused the data received by an EBCDIC program when a 'READ from SYSIN' was

performed to be in ASCII format has been corrected.

2657391 (1090401)
• CEE3PRM now successfully retrieves the parm value to the calling program.

2654879 (1090140)

MDSA API for CAS

Back to the list

• If an enterprise server instance is started by an Enterprise Server user account that has execute
privilege but not update privilege for that server, you now receive an INSUFFICIENT_ACCESS error
when the server starts.

2664445 (1091238)

MF Communications Server

Back to the list

• When using casout to get job information, sometimes you could receive an error and the output was
trucated.

2693283 (1093638)
• An issue where terminating 3270 sessions would result in high CPU usage in the MFCS process has

been fixed.

2682179 (1092886)
• The mfpackage utility for removing deployed services from Enterprise Server is now included with HCO

for SQL Server Tools.

2675212 (1092127)
• In version 2.2 of this product, the received data was missing from the trace messages for CTG and ISC

conversations. This has now been fixed.

2674286 (1091971)
• Some of the Enterprise Server functions for informing running enterprise server of security updates and

for retrieving the list of printers available on the server system were broken in Enterprise Developer 2.2.
This has now been fixed.

(601260)
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• You no longer receive exceptions in MFCS when the data-trace option is enabled for a CTG listener.

(601465)

MF Directory Server

Back to the list

• When using the export and import functionality of the MFDS XML Enterprise Server configuration, XRM
name and label definitions are now exported and imported correctly.

2683510 (1092852)
• When using the export and import functionality of the MFDS XML Enterprise Server configuration, the

open and close string properties of XRM resources now support the inclusion of double quotes.

2682635 (1092777)
• On Solaris SPARC, the value of the Enterprise Server Administration GUI journal size option was being

incorrectly set to zero.

2681195 (1092638)
• When adding or editing an IMS MPR definition in the Enterprise Server Administration GUI, you can

now use comma as a separator in the class field to enter multiple class definitions.

2676449 (1092164)
• The mfds export and import command line options -x and -g XML now also support exporting and

importing enterprise server script configuration information.

2668554 (1091412)
• XML import in the MFDS no longer fails if the XML source code contains long paths.

2668553 (1091409)
• When using the Enterprise Server Administration to edit the properties of JES Initiators, JES Printers,

IMS MPRs and XRMs, the GUI now rejects duplicate names.

2668020 (1091336)
• Session cookies in the browsers for the Enterprise Server Administration GUI now use the HttpOnly flag

for additional security.

2666975 (1091258)
• The browser auto-complete feature is now disabled for the password fields in the Enterprise Server

Administration GUI.

2666975 (1091260)
• If the Enterprise Server Administration HTML GUI is in "restricted access" state, a logged on user now

needs to have "administer user" levels permission to see the "Display" options in the LHS of the GUI.
This includes the "Directories", "Statistics", "Sessions" and "Journal" menu options. The "administer
user" option is available by default to any member of the #DSAdmin MFDS user group. In MLDAP ESM
security, this permission is defined by Update, Add or Delete ACE permissions against the "User
Administration" resource in the "Enterprise Server Administration" resource class under "Enterprise
Server Resources".

2663991 (1090934)
• When exporting the Enterprise Server configuration in XML format with the "mfds -x" command line

option, the MSS ISC and CTG listener information was not formatted correctly, which resulted in an
incorrect behavior when you reimported the XML configuration.

2651735 (1090147)
• When you use the Enterprise Server Administration HTML GUI to create a user group, the following

characters are no longer allowed in name: '< >', ';', '"' and '&'.

MF Server Administrator (GUI)

Back to the list
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• When trying to change a password from the Enterprise Server Administration HTML logon page,
additional checks are made before reporting the success or failure of the request.

2659582 (1090525)
• The execution scripts configured for an enterprise server instance can now use the credentials specified

on the Start\Stop page of the server in Enterprise Server Administration. For example, to use the
specified credentials to start an enterprise server instance, you need a script with the following
command:

• On Windows:

casstart /r%ES_SERVER% /u%TXUOPERATOR% /p%TXPOPERATOR%

• On UNIX:

$ES_SERVER, $TXUOPERATOR

Where:

• TXUOPERATOR resolves to the user id.
• TXPOPERATOR resolves to the password.

After the enterprise server instance uses these environment variables, they are reset to blank and are
no longer available to query.

2599100 (1086661)

MFIO

Back to the list

• MFGENER now works with the server using FCD3 protocol.

2676130 (1092134)
• The comments in the MFAVTAM sample member have been updated.

2674286 (1091976)
• SM2 no longer segfaults when a member has been deleted on the mainframe.

Micro Focus Heartbleed Update

Back to the list

The OpenSSL library used in this product has been updated to version 1.0.1g to fix the "Heartbleed"
vulnerability with TLS heartbeat requests.

NCG

Back to the list

• An error could occur at generate time for programs with calls to INTRINSIC functions that had multiple
ALL subscript parameters.

2695026 (1093885)
• An issue in cob which caused a core dump when all entry points in the main program were invalid has

been fixed.

2663974 (1090927)
• An issue has been resolved where the debugger would not step into the code when a PERFORM

statement is the last statement in a WHEN branch of an EVALUATE statement.

Run-Time System

Back to the list
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• When a container end event is received, all external files that are open in the container now close
correctly.

2513669 (1079282)

Setup Issues (UNIX)

Back to the list

• A problem with the installer where it was not performing a check for whether libstdc++ is installed has
been fixed. You no longer receive an error "CASCD0144S SEP 00002 for ES ESDEMO exited with
value 00127" when trying to start 32-bit enterprise servers.

2672995 (1092055)

SQL: COBSQL

Back to the list

• COBSQL Pro*COBOL error messages displayed only up to 80 characters.

2681983 (1092788)
• Previously, commented-out END-EXEC statements were causing a Compiler error. COBSQL now

ignores such statements.

2680341 (1092533)
• The COBSQL precompiler was updated so it does not attempt conversion of source lines containing the

continuation character.

2663986 (1090930)

SQL: DB2 ECM

Back to the list

• When a CREATE TABLE statement contained a PARTITION parameter, the HCO DDL processor
sometimes generated invalid DDL.

2682214 (1092725)
• A new option (SAVEDDL) is available in the HCO DDL processor. With this option set, any DDL

converted from the input DDL file is saved and not executed. The DDL processor now supports
specifying the IN <tablespace> and COMPRESS <option> parameters but not modifying them.

2673448 (1091907)
• Previously, the HCO IMPORT tool could go into a loop if the LOB column was in the import data set.

2673443 (1091887)
• When compiling on a 64-bit systems, the DB2 pre-compiler incorrectly generated an error "DB0121

Package name is too long."

2673259 (1091920)
• The HCO DDL processor now accepts column names greater than 18 characters. Previously, in this

situation, you received SQLCODE error -205 when the DDL was processed.

2673085 (1091829)
• The HCO IMPORT tool now supports a new parameter (SAVEDEL) which enables converting DSN

import files to delimited format. When used with this paramter, the HCO IMPORT tool only converts the
file and does not perform an actual import.

2672865 (1091891)
• The HCO Import Data tool was not checking for invalid lengths passed for VARCHAR column data; the

tool now checks this and when an invalid length is passed, issues an error message identifying the
affected column.
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2661781 (1091056)

SQL: HCO for SQL Server

Back to the list

• HCOSS now handles statements of type "SET hostVariable = CURRENT SQLID" correctly.

2693537 (1093690)
• The HCOSS Assess Application Migration tool flagged CALL statements as errors without checking

parameter directions. These CALL statements are now flagged as 'in doubt' to initiate an assessment of
parameter directions.

2685247 (1093156)
• The OpenESQL preprocessor and runtime now support AMODE(31) address pointers and swapping

COMP fields in SQLDA for user-defined mainframe style SQLDAs.

2684229 (1092978)
• COBOL stored procedures could not perform database updates when called from a SQL Server trigger.

2680257 (1092809)
• OpenESQL and HCOSS now correctly compile statements that contain CASE expressions.

2679336 (1092605)
• OpenESQL now supports a generic syntax for setting and rolling back to transaction save points that

work with Oracle, DB2, and SQL Server.

2676145 (1092138)
• Although mainframe DB2 supports FETCH INSENSITIVE from SENSITIVE STATIC cursors, which has

a SQL Server equivalent KEYSET cursor, SQL Server does not support FETCH INSENSITIVE from
KEYSET cursor. This is a permanent limitation.

2676140 (1092137)
• OpenESQL did not support BLOB, CLOB, and DBCLOB host variables larger than 64K.

2649752 (1089622)

SQL: OpenESQL

Back to the list

• OpenESQL did not support using the DB2 VALUES INTO statement with DB2 LUW.

2694069 (1093906)
• The OpenESQL preprocessor incorrectly rejected host variable character definitions that contained

x'091' characters.

2692065 (1093465)
• You can now specify SQL(NOCHECKSINGLETON) in applications that require compatibility with older

products to check for unfetched rows after a singleton SELECT. In such cases, the returned SQLCODE
value is zero rather than an error or a warning.

2691736 (1093420)
• The SQL(TSTAMPSEP)compiler directive could not be explicitly set to a space character, for example

SQL(TSTAMPSEP= ). This is now the default setting unless overridden by specifying
SQL(DIALECT=MAINFRAME).

2691212 (1093364)
• In the IDE, the TSTAMPSEP directive was not listed as an OpenESQL compiler directive option.

2685702 (1093116)
• When SQL(NODETECTDATE) is set after SQL(DIALECT=MAINFRAME), HCOSS does not attempt to

convert date, time or timestamp literals in static or dynamic SQL statements.
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2685422 (1093615)
• DB2 LUW applications could not use DECLARE GLOBAL TEMPORARY TABLE statements that were

not syntactically valid for DB2 z/OS.

2685219 (1093346)
• The sqlda.cpy copybook could not be compiled using the ENTCOBOL mainframe dialect.

2682522 (1092825)
• A new XA switch module is now available that supports XA recovery.

2680297 (1092528)
• Previously, you would receive error COBCH002 when SQL(NOPRE) was specified because the ODBC

precompiler would try to generate code using a variable which was not defined.

2679267 (1092438)
• The OpenESQL pre-compiler generated code that swap COMP host variables incorrectly if the SQL

statement got an SQL runtime error.

2677606 (1093013)
• The OpenESQL precompiler sometimes incorrectly generated swap code for COMP host variables if

they were used for both input and output in same SQL statement which resulted in SQLCODE of +100
being returned.

2675122 (1092454)
• A problem with SQL(CHECK) no longer occurrs when using binary host variables.

2673281 (1091832)
• A problem with nested select queries in ESQL 'select into' statements has been fixed.

2672519 (1091768)
• Previously, an incorrect code was generated for an INSERT statement that used an indicator variable

array when DBMAN=ADO was set.

2671938 (1091715)
• The support for EXEC SQL GET DIAGNOSTICS has been extended to include DB2_ROW_NUMBER,

ROW_NUMBER and COLUMN_NUMBER as diagnostic items that can be retrieved by an application.

2670955 (1091611)
• The OpenESQL preprocessor could sometimes improperly decode DBCS host variable characters

which resulted in receiving an "ES0109 Invalid data name" message.

2670725 (1091594)
• The OpenESQL pre-compiler incorrectly changed the underscore character (_) to a dash character (-)

in an EXEC SQL WHENEVER statement.

2670723 (1091593)
• Dynamic SQL statements were not releasing JDBC cursors.

2670548 (1091585)
• OpenESQL for JVM COBOL prevented type byte[] host variables from being used.

2667023 (1091240)
• The SQL Directives information available within the Visual Studio and Eclipse IDEs contained an error

regarding the available options for the XDB(DATE) and XDB(TIME) directives.

2666213 (1091185)
• Some issues relating to the use of PIC G /PIC N DISPLAY-1 and some DBCS host variables have been

resolved.
• When using Data Direct ODBC drivers, PIC N NATIONAL host variables always uses UTF-16 instead

of UTF-8 which previously happened on some platforms.
• Some problems with using Data Direct's ODBC driver for Microsoft SQL Server have been fixed.
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UNIX Cob

Back to the list

• Cob now checks for duplicate symbols defined in objects that are passed to cob for linking.

2651626 (1089779)
• Previously, ccbl was leaving behind a file named cobxi* in the $TMPDIR or /var/tmp directories.

Web Service Client

Back to the list

• Support for nested COUNT IN clauses has been added to the generated Web Service Console Client.
Empty and unused array fields will no longer be returned in the client output.

2278428 (1066547)

XDB Server

Back to the list

• MFDB2UNL.CBL now allows the use of semi-colons within SQL statements.

2661513 (1090755)

XDB: Problems not classed above

Back to the list

• Previously, TESTCOVER configuration could cause spurious errors in XDB utilities.

2677742 (1092299)

XML Syntax Support Preprocessor

Back to the list

• PREXML now handles conditional compilation correctly.

2665552 (1091113)
• An XML file being opened for input is now closed correctly.

2664760 (1091006)

XML Syntax Support Runtime

Back to the list

• The XML run-time system now handles non-US EBCDIC characters correctly.

2665518 (1091086)
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Updates and SupportLine
Our Web site gives up-to-date details of contact numbers and addresses.

Further Information and Product Support
Additional technical information or advice is available from several sources.

The product support pages contain a considerable amount of additional information, such as:

• The WebSync service, where you can download fixes and documentation updates.
• The Knowledge Base, a large collection of product tips and workarounds.
• Examples and Utilities, including demos and additional product documentation.

To connect, enter http://www.microfocus.com in your browser to go to the Micro Focus home page.

Note: Some information may be available only to customers who have maintenance agreements.

If you obtained this product directly from Micro Focus, contact us as described on the Micro Focus Web
site, www.microfocus.com. If you obtained the product from another source, such as an authorized
distributor, contact them for help first. If they are unable to help, contact us.

Information We Need
However you contact us, please try to include the information below, if you have it. The more information
you can give, the better Micro Focus SupportLine can help you. But if you don't know all the answers, or
you think some are irrelevant to your problem, please give whatever information you have.

• The name and version number of all products that you think might be causing a problem.
• Your computer make and model.
• Your operating system version number and details of any networking software you are using.
• The amount of memory in your computer.
• The relevant page reference or section in the documentation.
• Your serial number. To find out these numbers, look in the subject line and body of your Electronic

Product Delivery Notice email that you received from Micro Focus.

On Windows, if you are reporting a protection violation you might be asked to provide a dump ( .dmp) file.
To produce a dump file you use the Unexpected Error dialog box that is displayed when a protection
violation occurs. Unless requested by Micro Focus SupportLine, leave the dump setting as Normal
(recommended), click Dump, then specify a location and name for the dump file. Once the dump file has
been written you can email it to Micro Focus SupportLine.

Alternatively, you might be asked to provide a log file created by the Consolidated Tracing Facility (CTF) -
a tracing infrastructure that enables you to quickly and easily produce diagnostic information detailing the
operation of a number of Micro Focus software components.

On UNIX, you can use the Micro Focus UNIX Support Scan Utility, mfsupport, to create a log file that
contains the details about your environment, product, and settings. The mfsupport script is stored in
$COBDIR/bin.

To run mfsupport:

1. Start a UNIX shell.
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2. Set COBDIR to the product with issues.
3. Execute mfsupport from a directory where you have write permissions.

This creates a log file, mfpoll.txt, in that directory.
4. When the script finishes, send the mfpoll.txt file to your Micro Focus SupportLine representative.

Note:

If COBDIR is set to a location that does not contain etc/cobver, the script outputs the contents
of /opt/microfocus/logs/MicroFocusProductRegistry.dat which keeps a list of the
installed Micro Focus products.

Creating Debug Files
If you encounter an error when compiling a program that requires you to contact Micro Focus SupportLine,
your support representative might request that you provide additional debug files (as well as source and
data files) to help us determine the cause of the problem. If so, they will advise you how to create them.
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Disclaimer
This software is provided "as is" without warranty of any kind. Micro Focus disclaims all warranties, either
express or implied, including the warranties of merchantability and fitness for a particular purpose. In no
event shall Micro Focus or its suppliers be liable for any damages whatsoever including direct, indirect,
incidental, consequential, loss of business profits or special damages, even if Micro Focus or its suppliers
have been advised of the possibility of such damages. Some states do not allow the exclusion or limitation
of liability for consequential or incidental damages so the foregoing limitation may not apply.

Micro Focus is a registered trademark.

Copyright © Micro Focus 1984-2014. All rights reserved.
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